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Abstract

The Gamma Detector Response and Analysis Software–Detector Response Function (GADRAS-DRF) 
application computes the response of gamma-ray and neutron detectors to incoming radiation. This 
manual provides step-by-step procedures to acquaint new users with the use of the application. The 
capabilities include characterization of detector response parameters, plotting and viewing measured and 
computed spectra, analyzing spectra to identify isotopes, and estimating source energy distributions from 
measured spectra. GADRAS-DRF can compute and provide detector responses quickly and accurately, 
giving users the ability to obtain usable results in a timely manner (a matter of seconds or minutes).
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1 INTRODUCTION

1.1 GADRAS-DRF Overview

GAmma Detector Response and Analysis Software – Detector Response Function (GADRAS-DRF) 
contains a suite of capabilities related to radiation detection. Its primary function is the simulation of 
gamma-ray and neutron detector signals to radiation sources. It also contains limited analysis 
functionality. GADRAS-DRF is the public version of the full version of GADRAS [1] with capabilities 
such as radiation transport [2] [3] and advanced analyses [4] removed.

Features in a gamma-ray detector spectrum; such as photopeaks and the Compton continuum, are derived 
from first-principles calculations based on interaction cross sections. Neutron detector response is 
computed by interpolating on a pre-computed database of thermal (3He) detector responses [5] [6]. For 
both gamma-ray and neutron detectors, the response to radiation that scatters into the detector from the 
surrounding environment is determined by a combination of first-principals calculations and empirical 
modeling [7]. For new detectors, known detector parameters such as size and resolution are all that is 
necessary to compute an initial response function. This response function may be refined by measuring 
calibration sources and fitting the detector’s parameters to match the data.

Figure 1 is a screen-capture of the GADRAS-DRF main window. The program contains six main tabs that 
run across the top of the window (Detector, Plot, Analyze, Neutron, Tools, and Setup). Each tab 
represents a primary function of GADRAS-DRF; these are referred to as tabs in this document (e.g. Plot 
tab). Most tab pages have a primary function initiated by clicking a large button in the bottom right corner 
of the screen. The title of the main window displays the current version and currently selected gamma-ray 
detector. GADRAS-DRF must always have a current gamma-ray detector selected, even if the current 
operation does not require a detector response function (e.g. plotting a measured spectrum). Neutron 
detectors are optional; the current detector name will also appear on the main window title. 
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Figure 1: Overview of Main Window

1.2 Directory Structure

Within the root GADRAS-DRF directory (default is C:\GADRAS-DRF), there are four primary 
directories: (1) Detector, (2) Source, (3) Temp, and (4) Program (Figure 2). 
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Source Definitions
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Definitions

(3) Temp
Log Files

Temporary Files
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Documentation

API Examples

Application Manual
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Figure 2: Overview of GADRAS-DRF Directory Structure

The Detector directory contains subdirectories, each for a different gamma-ray detector. The name of the 
subdirectory indicates the name of the detector; thus, each gamma-ray detector requires its own directory. 
However, multiple neutron detectors can be added to a single gamma-ray detector directory. A common 
practice is to use a gamma-ray detector directory as a scenario or experiment repository containing 
documents and measured spectra. Therefore, detector directory names are also based on experiments (e.g. 
“GADRAS-DRF\Detector\BeRPBall”).

Common source files shared among multiple detectors are stored in the Source directory. Source files 
may be stored in individual detector directories as well. 

The Temp directory is cleaned with each new instance of GADRAS-DRF. It contains temporary files 
which facilitate faster operation of the program as well as log files which record debugging information. 
Most users will not need to explore this directory.

The main executable is located in the Program directory at “GADRAS-DRF\Program\GADRAS-
DRF.exe” along with associated shared libraries. This also contains a Documentation directory which 
contains this user’s manual as well as example codes that utilize the GADRAS-DRF API.
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2 DETECTOR RESPONSE FUNCTION 

2.1 Creating New Detectors

Each detector directory contains a file named Detector.dat, which contains the response function 
parameters. Response function parameters do not normally require adjustment after initial 
characterization. Specific situations where parameter adjustments are necessary include:

 Occasional adjustments for energy calibration drift;
 Change in source-to-detector distance or height from the floor;
 Adjustments needed due to mechanical damage, chemical deterioration, high voltage bias 

change, shielding, etc. that have caused the detector to change its characteristics substantially; 
and

 Changes in the experimental environment.

2.1.1 Using the Create New Detector Screen: Clone or Create Options

A new detector setup within GADRAS-DRF can be created from the Detector tab on the main window. 
To create a new setup, the user must select Create New Detector from the drop-down menu as shown in 
Figure 3 (top). This action opens the Create New Detector form shown in Figure 3 (bottom), which 
allows users to clone an existing detector or create a new detector.

The following entries are mandatory for creating new detector setups:

1) Detector name: Users should create a unique name for the detector.
2) Parent directory: The parent directory for the detector. By default, this is the main detector directory 

“GADRAS-DRF\Detector”. Any subdirectory of the main detector directory may be used (including 
existing detector directories) to be the new detector’s parent directory. 

3) Source-to-detector distance: A value must be entered upon detector creation, but this value can be 
modified at any time if needed. The value is given in centimeters, but other units may be used (see 
Section 2.2).
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Figure 3: File Drop-down Menu (top) for Create New Detector Dialog (bottom)

New detectors may be created by clicking the Clone button located in the middle of the window or the 
Create button located at the bottom of the window.

1) Clone: An existing detector is copied using either the provided dropdown list or the Browse button. 
After choosing the appropriate detector, clicking the Clone button will create the new directory with 
the appropriate Detector.dat file. 

2) Create: This option generates a new Detector.dat file. Select the detector type (e.g. NaI, HPGe, etc.) 
from the dropdown list. The number of channels and the detector efficiency or detector dimensions 
should be entered. (Note: The Length dimension is along the line defined by the two points: (1) the 
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center of the source and (2) the center of the front face of the detector.) The user can then click the 
Create button to create the new directory with the appropriate Detector.dat file.

When creating an HPGe detector, the user can enter the relative efficiency of the detector compared 
to a standard 3×3 NaI detector at 1332.5 keV with a source-to-detector distance of 25 cm. 
GADRAS-DRF will subsequently assign typical physical dimensions. 

Selecting None for the detector type will simulate a perfect radiation detector. Computed source 
spectra will be composed of the leakage current from the source and the solid angle of the detector. 
No peak broadening or any other physics associated with a real detector are applied. 

2.1.2 Copying an Existing Detector Response Function (Detector.dat)

Detector.dat files for characterized detectors are contained in subdirectories under the primary detector 
directory “GADRAS-DRF\Detector”. Detectors may be copied using a Windows Explorer window. An 
existing Detector.dat file can be copied and pasted manually to a new directory to create a new detector 
parameter file that GADRAS-DRF will recognize as a valid detector. 

Note: It is advisable to always work on copies of distributed Detector.dat files as opposed to modifying 
the original. Working on original files may compromise them. Furthermore, each release and install of 
GADRAS-DRF will overwrite any changes to the original files.

GADRAS-DRF expects spectral data files and the response function file (i.e. Detector.dat) to reside 
together in the same subdirectories of “GADRAS-DRF\Detector”. The main criterion for GADRAS-DRF 
to recognize a detector directory is the existence of a Detector.dat file. The application will not recognize 
multiple Detector.dat files in the same directory.

2.2 Detector Parameters in Detector.dat Files

From the Detector tab, the detector response function parameters (as found in the Detector.dat file) can 
be accessed and edited. For example, these parameters are displayed in Figure 4 for a NaI detector. For 
other detector types, similar screens are displayed with some detector-specific variations. Response 
function parameters are grouped on the page and will be discussed using these headings.

Dimensions and distances can be entered in the following units: centimeters, meters, feet, or inches. 
GADRAS-DRF will convert the user input to centimeters. The convention for entering alternative 
dimensions is to type an identifying letter after the numerical entry. The identifiers for meters, feet, and 
inches are “m”, “f”, and “i”, respectively. For example, to enter 12 inches as the distance, you would type 
“12i” into the distance entry box; unit conversion is performed automatically so that distance is displayed 
in centimeters after entering the character “i”.

The following sections briefly describe the function of each field on the Detector tab. For more 
information, see reference [8].
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Figure 4: Example Detector Response Function Parameters for a NaI Detector

2.2.1 Energy Calibration

Routine energy calibration is usually performed elsewhere in GADRAS-DRF. Adjusting the energy 
calibration is discussed in Section 6.

The energy calibration parameters are described in reference [8]. There are a few general remarks about 
what values might be reasonable for the calibration of a detector. 

 E0 or Order 0 in Energy: should a small number (<100) either positive or negative 
 E1 or Order 1 in Energy: should be a number close to the maximum energy scale of the detector 

in keV
 E2 or Order 2 in Energy: should be zero unless the detector is non-linear
 E3 or Order 3 in Energy: should be zero unless the detector is highly non-linear
 Low Energy: non-linear high order parameter (usually zero)

In general, it is advised to initially have values for E0 and E1.

2.2.2 Resolution

The following parameters can be used to modify the detector resolution:

 keV @ E->0 is the limit of the FWHM as the photopeak energy approaches 0 (can be negative)
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 keV @ 1332 (%FWHM@661) is the FWHM of the photopeak at 1332 keV (or %FWHM at 661 
keV for non-HPGe detectors)

 Energy power describes the rate at which the FWHM increases as a function of energy. If the 
energy power is , then the equation for FWHM (keV) for a photopeak at energy  (keV) isn E

FWHM ‐ En

 Low-E Skew describes the magnitude of photopeaks’ low energy tails
 High-E Skew describes the magnitude of photopeaks’ high energy tails

2.2.3 Geometry

The default detector configuration with respect to the measured source is described by the following 
parameters:

 Distance is the source-to-detector distance in cm measured from the center of the source to the 
center of the detector face. 

 Height is distance in cm above the ground. For most applications it is assumed that the detector 
and source are at the same height.

2.2.4 Detector Dimensions

The following parameters describe the detector dimensions:

 Setback is the distance in cm from the physical surface of the detector face to the active sensor 
element (crystal).

 Length is the detector length in cm measured perpendicular to the detector face. 
 Width is the detector width in cm measured perpendicular to the incident photon flux and parallel 

to the floor. 
 Height/Width is the ratio of the two dimensions perpendicular to Length. 

Although these parameters describe a rectangular detector, other geometries can be approximated 
using these dimensions. For example, a cylindrical detector oriented so that the axis is pointed toward 
the radiation source can be approximated by a square with the same surface area as the circle (i.e., 
height × width = πr2). The conversion between diameter and width can be performed by typing “d” 
after specifying the numerical value for the diameter.

 Shape and Shape factor (S) are parameters that describe the distribution of path lengths through 
which incident radiation travels as it traverses the detector. The shape factor describes a 
continuous function that varies from about 3 for circular cross sections (e.g. radiations enters 
predominantly through side of a cylindrical detector) to about 100 for flat detector profiles (e.g. 
radiation enters through top or bottom of cylindrical detector). Figure 5 shows detector profiles 
for several values of S. Note that the detector shape can vary depending on the orientation of the 
radiation source with respect to the detector. In the case of a cylindrical detector oriented so that 
the radiation source is located on the axis of the detector, the value of S is about 100, which 
describes a flat profile. Alternatively, from the shape entry, the user can select one of three shapes 
(flat, circular, or custom) and the shape factor value will automatically be adjusted.
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Figure 5: Detector Cross-section Profiles for Several Shape Factors

2.2.5 Scatter Parameters

GADRAS-DRF includes a library of scattering kernels which are used to calculate scattering 
contributions from any surfaces present in the environment surrounding the source and the detector. The 
source-to-detector distance and height determine the position of the source in a nominal room. The 
scattering magnitude is sensitive to height, so it is important that this parameter is accurate. The Clutter 
parameter determines the average distance from the detector to the walls in the room. The following 
guidelines can be used when determining initial scatter parameters:

 Outdoors/Large Room should have a small Clutter term (less than 3).
 Average Room should have a Clutter term equal to 3 (indicates an average distance of 3 meters 

to the surrounding walls in the room).
 Small Room should have a Clutter term that is computed using the equation 900/{average 

distance to the walls in cm}.

The scatter parameters labeled 0 Degrees, 45 Degrees, 90 Degrees, 135 Degrees, and 180 Degrees adjust 
the magnitude of the scattered radiation. The 0 Degrees parameter corresponds to low-angle scattering 
within the environment, which manifests itself as continuum just below the photopeak energy. The 180 
Degree parameter corresponds to a photon which has backscattered in the environment and manifests 
itself in the backscatter peak. A value of 3 in these fields describes indicates that the observed scattering 
continuum in the detector is consistent with the external environment. Values may exceed 3 if additional 
scattering occurs within the detector housing. Setting the scatter terms to zero disables the computation of 
scattered radiation.
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For special environments (e.g., source and detector are not at the same height, or placed in a corner), a 
user can define an Environment.dat file in the detector directory. An example Environment.dat file is 
located in “GADRAS-DRF\Detector\3x3\NaI AboveSource”.

2.2.6 Neutron 

Most gamma detectors are sensitive to neutron radiation. These parameters define the intensity of 
neutrons on the gamma detector:

 Environment Drop-Down Box describes the reflection of neutrons in the surrounding 
environment, also called the room return. Options are “No reflected neutrons”, “Outside or large 
bay”, “Indoors above suspended floor”, and “Indoors above concrete on ground”. The neutron 
reflection is dependent on the distance and height parameters as well. 

 Thermal Stopped % is the percent of thermal neutrons that are stopped by exterior shielding 
around the detector sensor

 Reflection Scalar directly scales the rate of neutrons reflected by the surrounding environment 
uniformly across all energies

2.2.7 Computation Options

 Inbin this checkbox toggles the usage of the Inbin.dat file. Inbin.dat defines relative channel 
widths and is useful for detectors with non-uniform channel widths. This checkbox is only 
enabled if Inbin.dat is present in the current detector directory.

 Rebin this checkbox toggles the use of the Rebin.dat file. Rebin.dat contains a list of energy 
groups, usually less than the detector’s total channel count, to reduce computation time for certain 
analyses. This checkbox is only enabled if Rebin.dat is present in the current detector directory. 

 Pileup this checkbox toggles whether or not GADRAS-DRF should simulate pileup from intense 
or close sources. See Section 2.2.9.2 for additional information on pileup.

2.2.8 Attenuator

The third column of the Detector tab file is composed of different attenuator types and settings. These 
parameters are provided in GADRAS-DRF to describe the attenuation of incident radiation before it 
passes into the active detector volume. These are useful in describing attenuation from detector housing, 
shielding, and collimators.

To define an attenuator, the effective atomic number (AN) and areal density (AD) (in g/cm2) (density 
multiplied by thickness) must be entered. For porous materials, the porosity of the attenuating material 
can be provided, this allows for a shield with holes or apertures. These attenuation corrections are applied 
to all incident radiation, including the computed flux of photons scattered into the detector from the 
external environment. 

 Inner Attenuator: describes the attenuation associated with the detector enclosure and the 
surface dead layer.
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 Outer Attenuator: describes additional shielding placed between the detector and source, such 
as graded shielding to reduce fluorescent x-rays.

 Shield Attenuator: describes the shielding on the sides and back of the detector. 
 Shielding materials are specified by specifying a % side shield parameter and a % back shield 

parameter. The % side shield is defined as the percent of the side of the detector that is 
surrounded by the shield. This will be set to 100 if the shield completely covers the sides but does 
not extend in front of the face of the detector. The length of the shield is described as a percent of 
the detector length, so collimators can be described by entering a value that is greater than 100%. 
For example, a value of 230 indicates that the length of the shield measured from the back of the 
detector to the front of the shield is 230% of the detector length (i.e., the shield extends 1.3 times 
the detector length in front of the detector). Similarly, % back shield is defined as the percent of 
the back of the detector that is surrounded by the shield. For collimators with an aperture less than 
the diameter of the active detector element, the Alt Collimator Diam field allows specification of 
the aperture size.

 Air Attenuator: describes attenuation associated with intervening air and is only significant 
when the source-detector distance is greater than about ten meters. Air attenuation is determined 
by the atmospheric pressure or the elevation.

2.2.9 Other Parameters 

2.2.9.1 External Annihilation

High-energy gamma-rays can form electron-positron pairs by interacting with materials near the detector 
crystal, such as detector housing. When this occurs, the positron annihilates with a nearby electron, and 
two 511 keV photons are emitted. The Ext. Annihilation parameter adjusts the magnitude of this effect.

2.2.9.2 Random Pileup and the Shaping Time Constant

The effect of random pileup is estimated in GADRAS-DRF using a provided pileup check box and 
entering an appropriate amplifier shaping time constant (Shape Time (μs)) parameter. To consider the 
effects of pileup, the pileup check box must be checked (the default setting). In addition, an approximate 
Shape Time (in microseconds) is required. Since the amplifier shape time constant is generally only 
approximate, it is often necessary to characterize this parameter from calibration spectra. 

When pileup rejection techniques are used, the Shape Time constant field should be entered as a negative 
value, with a magnitude approximately equal to the shape time constant in microseconds. The value 
should be approximately -5 for typical HPGe detectors equipped with pileup rejection circuitry.

2.2.9.3 Local X-ray Source and Magnitude

Gamma-ray detectors are often surrounded with lead or other high-Z materials as a shield. These shields 
emit fluorescence x-rays when excited by incident radiation. The resulting x-rays can be eliminated by 
lining the shield with lower atomic number materials like copper. However, these liners may not be 
included when the x-rays do not interfere with the gamma-rays of interest. 
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The adjustable parameters that characterize fluorescent x-rays include Local X-rays (source material) and 
X-ray Magnitude (x-ray intensity). An approximate energy dependence is applied for these x-rays. X-
rays have two main sources: (1) photons that scatter out of the active detector element into the high-Z 
material, and (2) photons that interact directly in the high-Z material. Note: the single parameter 
characterization may not be adequate if high precision is required in the x-ray region using high-Z 
shields.

2.2.9.4 Betas

When beta particles undergo negative acceleration, radiation is emitted in the form of bremsstrahlung 
photons. Bremsstrahlung radiation is displayed as a continuum with the maximum intensity at low energy 
and extending up to the end point energy of the beta particles. The Betas parameter provides the ability to 
estimate the continuum produced by bremsstrahlung emission. A good first estimate for this parameter is 
20. Note: Except for limited cases, a correction of this bremsstrahlung parameter is neither necessary nor 
advised. If a more accurate representation is required, a radiation transport calculation should be 
performed. 

2.2.9.5 % Holes Trapped

This is used as an empirical term related to hole trapping by detectors such as CdTe. This parameter does 
not have quantitative significance.

2.2.9.6 Dead Layer

The dead layer describes the depth of the inactive region between the contacts and the semiconductor in a 
solid-state detector. Typical values are a less than a few millimeters, depending on the manufacturing 
technique employed. This primarily affects low-energy intensities such as x-rays.

2.2.9.7 Efficiency Scalar

The efficiency scalar directly scales the simulated channel counts uniformly across the entire energy 
range. This can be useful when a single detector is characterized, but a system utilizes an array of multiple 
detectors and sums their signals for higher efficiency.

2.2.9.8 Template Err

This parameter defines the average percent error that is applied when the variance is estimated.

2.2.9.9 LLD

The lower-level discriminator setting in keV is represented by this setting. The simulated LLD is not a 
step-function; the slope of the simulated spectrum at the LLD is determined by the detector’s resolution.

2.2.9.10 Frisch grid

Frisch grids are used in conjunction with some CZT detectors. The percent of events that are recorded 
between Frisch grid electrodes is described by this parameter. Events recorded in this region can produce 
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up to twice the apparent full energy because both electrons and holes are counted; whereas holes are 
excluded for interactions within the bulk material.

2.2.9.11 Detector and Weight Range

The detector type has a drop-down menu which should match the user’s detector type. The number of 
detector channels is either what the user specified when the detector response function was created or is 
the default value from the cloned detector.

The Weight Range area has two fields: Lower Limit and Upper Limit. During any analysis or fitting, 
GADRAS-DRF will attempt to fit only the region of the spectrum defined by these limits. Grayed-out 
regions in the plot indicate ignored portions of the spectrum and are not used in any analysis or fitting 
routine.

2.2.9.12 Anticoincidence (AC) Shields

In some detector systems, the primary detector is surrounded by another detector, called an 
anticoincidence (AC) shield. This reduces background by rejecting events recorded simultaneously in 
both detectors. AC shields reduce the Compton continuum by excluding interactions where a photon 
scatters between the primary detector and the AC shield. The default setting is no AC shield. The effects 
of AC shields can be treated by defining the parameters under the Anti-Coincidence Shield section:

 Type: The type of AC shield detector material (e.g. NaI)
 Solid Angle: Solid angle subtended by the AC shield from the primary detector
 Thickness: Thickness in cm of the AC shield
 Dead Layer Z: Average atomic number (AN) of the dead layer on the AC shield
 Dead Layer AD: Areal density of the AC dead layer in g/cm2

 Shield LLD: Lower-level discriminator of the AC shield

2.3 Detector Tab Menu Items

2.3.1 File Menu

As seen at the top of Figure 3, the File menu allows users to save the current detector parameters or to 
browse the detector directory. Clicking on Save Detector Changes or pressing Ctrl+S will save the 
current detector parameters to the Detector.dat file. If changes are made and the user attempts to navigate 
away from the Detector tab or attempts to close GADRAS-DRF without saving the parameters, 
GADRAS-DRF will prompt the user to save the detector parameters. Click Browse Detector Folder or 
press Ctrl+B (on any tab) to open a new Windows Explorer window for the current detector directory.
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2.3.2 Calibrate Menu

2.3.2.1 Energy and Resolution Calibration

The Calibrate menu item automatically adjusts detector parameters. The Automatic Calibration (ecal 
and resolution) option shown in Figure 6 can be used to perform an energy calibration and resolution 
adjustment automatically using an existing spectrum. This option is described further in Section 6.1.

Manually energy calibration by choosing peaks in a spectrum is done through the Peak Search and 
Manual Energy Calibration option under the Calibrate menu. This is described further in Section 6.2. 

Figure 6: Calibrate Menu on Detector Tab

2.3.2.2 Response Function Parameters

To optimize other parameters, choose the Response Function option in the Calibrate menu. This option 
adjusts the parameters that the user has selected in order to match measured calibration spectra to 
computed spectra. To select a parameter for adjustment, users should click on the label of the parameter. 
Parameters that are highlighted in cyan have been chosen for adjustment. After clicking on the Response 
Function option, users are presented with the Detector Response Function Calibration form. This 
form, which is shown in Figure 7, looks very similar to the Plot tab (Section 4). 
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Figure 7: Detector Response Function Calibration Form

Using entries from the PCF Viewer window (Section 3), users can add up to six SpecPairs to use in the 
calibration. Users should specify a Foreground and Background as well as a Source for Computed 
Spectrum. GADRAS-DRF will subtract the Background from the Foreground (using count rates in each 
energy bin) and compare the measured spectrum to the computed spectrum for the specified source. It 
will do this comparison for each SpecPair specified in the Calibration form. GADRAS-DRF will then 
vary the adjustable parameters and find the best parameter fit through non-linear regression iterations.

To effectively calibrate a new detector to measured spectra, it is highly advised to determine the energy 
calibration a resolution before varying other parameters in the Detector tab. Users should also not attempt 
to vary all the parameters at once, as this will lead to degenerate solutions that may not reflect the best 
detector response parameters for a given setup. Users instead should vary energy and resolution 
parameters first, then attenuators and scattering parameters. Some parameters may be known prior to 
performing the Response Function Calibration (such as Shape Time or Shield Attenuator properties). In 
this case, users should put in the parameters before attempting any detector response function calibrations.

2.3.2.3 Linearize Spectra

The Linearize Spectra option in the Calibrate menu item applies a linear energy calibration to all 
spectra in the current PCF file. This option will only work if a PCF file is currently open in the PCF 
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Viewer window. By selecting this option, all spectra in the PCF file will be assigned a linear energy 
calibration and use the defined deviation pairs (if any).

2.3.3 Restore Points

Restore points allow users to save the current detector response parameters. If users are trying to improve 
on an existing detector response function, but do not want to lose the original parameters, they may create 
a Restore Point. This is done by selecting Create New under the Restore Points menu item (Figure 8). If 
the detector parameters are adjusted incorrectly, detector parameters can be reverted to a set of previous 
parameters by clicking the appropriate Restore Point.

Figure 8: Restore Points Menu Item
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3 PCF SPECTRAL FILE 

3.1 What is a PCF File

The main file format intrinsic to GADRAS-DRF is a binary, direct access file with a PCF extension. 
GADRAS-DRF can read many other spectral file formats (e.g., Ortec CHN, IAEA SPE, ASC, PCC, 
N42, etc.) from many vendors and convert them to the GADRAS-DRF preferred PCF file format. 
GADRAS-DRF writes energy calibration coefficients and other supplemental information directly into 
PCF files. 

GADRAS-DRF generates and stores PCF files in the same file location as the Detector.dat file. This is 
typically a user chosen subdirectory in “GADRAS-DRF\Detector”. The Detector.dat file must be defined 
prior to evaluating spectral data. Selection or creation of the detector (Detector.dat file) is discussed in 
Section 2.1. A PCF data file can be generated or created from the Plot tab on the main screen. To do this, 
the user can select New from the File drop-down menu, as shown in Figure 9. This action opens a 
Windows Explorer window (Figure 10) with “eventList.pcf” as a default file name for the PCF. This file 
name can be modified by the user, if desired. The default location is the current detector directory. After 
any necessary changes are made, click the Windows Explorer Open button and the PCF Viewer will 
display a blank PCF file as shown in Figure 11.

Figure 9: Creating a New PCF File From the Plot Tab Within the File Menu
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Figure 10: PCF File Name Selection

Figure 11: Newly Created PCF Shown in the PCF Viewer

Spectral files of almost any format can be added to the blank PCF by dragging and dropping the desired 
data file to the gray area in the PCF Viewer. Figure 12 shows the file list form after populating the PCF 
file with eight spectral entries (five calibration source spectra and three background spectra). 

GADRAS-DRF can process spectral data taken at different source-to-detector distances and heights. 
Processing the spectral data is facilitated by entering the source-to-detector distance for each spectrum in 
the file title field so that these values are entered as defaults when computed spectra are compared with 
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measurements. The source-to-detector distance must be contained between the character “@” and the 
string “cm” or “m,” indicating distances in centimeters or meters, respectively. The interpretation of the 
string defining distance is not case sensitive. If the detector height is also entered, the height must be 
contained between the string “H=” and the string “cm” or “m.” Similarly, the strings are not case 
sensitive. For example, a spectrum taken at a height of 20 cm and a source-to-detector distance of 50 cm 
can have the following string in the Title “@ 50 cm H=20 cm”. Figure 12 shows the PCF Viewer with 
the “Th-228 @ 122 cm” entry highlighted in blue and a spectral preview on the right in red. 

Figure 12: PCF Viewer with Eight Spectra (left) and the Spectral Preview of the 
Highlighted Entry (228Th Spectrum) Displayed (right).

3.2 Editing PCF Files

The PCF Viewer edits the contents of a PCF file. Each entry or row in the PCF Viewer is a spectrum 
stored in the PCF file. Editing cells in this table immediately edits and saves the contents of the PCF file. 
Editable fields include Tag, Title, Date & Time, TL (live time), TT (total time), and N (neutron count 
rate). If users inadvertently change a field in the PCF file, they can choose Restore to Last Backup in the 
PCF Viewer’s File menu.

3.3 PCF Viewer Menu Items

Under the File menu, the Open option loads an existing PCF file; the New option creates a new one; the 
Print command sends the contents of the PCF Viewer window to a printer.

The Options menu item allows users to select which columns should be displayed in the PCF file. There 
is also an option to toggle the spectrum preview window on the right side of the PCF Viewer.



34



35

4 PLOTTING/VIEWING SPECTRA

4.1 Measured Spectra

Users can plot one or more gamma-ray spectra in a PCF file using the Plot button located on the bottom-
right corner of the Plot tab (Figure 13).

A record of interest from a PCF file can be plotted by dragging and dropping an entry from the PCF 
Viewer to the Foreground text box or to the plot table that lists current Spectral Pairs. The plot table 
consists of three columns. The first column is the Title of the SpecPair, which is the title of the 
Foreground spectrum if present. If the Foreground is absent, the Title will be the Computed Spectrum 
name. If this is absent, the Title will be “Unknown” and will not be included in the plot display. The 
second column is the File associated with the SpecPair. This will be the foreground spectrum file name 
and record, or the computed source file name if the foreground textbox is blank. The third column 
specifies the background associated with the SpecPair. A spectrum specified in the Background textbox 
is time-normalized to the current foreground spectrum and is subtracted from the foreground before being 
displayed on the Plot tab. Clicking the Plot button will display the desired background-subtracted spectra. 
Figure 14 shows a plot of a 228Th spectrum.

Figure 13: Plot Tab with Entries to be Plotted From the “cal.pcf” File.

The Add SpecPair and Delete SpecPair buttons in the middle of the screen are used to add or remove 
spectra from the drawn plot. When the Add SpecPair button is clicked, GADRAS-DRF adds the 
subsequent record from the current PCF file to the Foreground spectrum. The previous Background 
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record is maintained by default. If the previous foreground record was the last record in the PCF file, the 
same foreground is added to the table again.

Figure 14: Plot of Background Subtracted 228Th Spectrum.

Figure 15 shows a plot with three spectral pairs selected for graphing. These pairs are displayed in the 
central white area of the Plot tab. Up to six spectra can be selected and displayed in a single graph. 



37

Figure 15: Plot Tab Example with 3 Background Subtracted Spectral Pairs Identified for 
Plotting

Figure 16 shows the graph of the three spectral pairs identified in Figure 15. The graphs are identified for 
each spectrum by the color selected in the style box in the Plot tab. The 137Cs plot is displayed in purple 
as shown in the style box in Figure 15.
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Figure 16: Plot of the Three Background Subtracted Spectral Pairs: 228Th (black), and 88Y 
(blue), and 137Cs (purple).

4.2 Zooming and Navigating a Plotted Spectrum

After the plot is displayed, navigation can be done with the mouse. Drag from left to right to zoom-in on a 
region of interest as shown in Figure 17. Drag from right to left a small amount to partially zoom out. 
Drag from the right to left a larger amount to completely zoom out. Use the mouse wheel if available to 
change the number of log cycles displayed, or to switch between linear and logarithmic scales. Other 
graph navigation options can be set from the Setup tab.



39

Figure 17: Zooming-in on a Plotted Spectrum.

4.2.1 Plot Display Screen File Menu

The File menu consists of the following options: 

 Copy to Clipboard (Ctrl+C): copies the plot screen to the clipboard as an image and can be 
pasted into another application

 Save to Metafile (Ctrl+S): saves the plot screen to an image file (.emf)
 Print: allows users to print the displayed graph

4.2.2 Plot Display Screen Tools Menu

The Tools menu provides options for graph properties, peak lists, and count rates: 

 Zoom to Extents: zoom the graph out to the full energy limits
 Count Rates: provides the count rate for each of the graphed spectra at the currently displayed 

energy limits
 Peak Search Mode: provides energy and count rates for peaks in the spectrum in graphical and 

list form
 Edit Deviation Pairs: allows the user to view and edit the deviation pairs associated with the 

current spectrum
 Options (graph options)

o X-Axis Minimum and Maximum: sets the minimum and maximum energy (keV) limits 
for the graph 
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o X-Axis Units: choose between Channel Number and Energy (keV) (if Channel Number 
is chosen, the energy scale is moved to the top of the graph) 

o Y-Axis Units: choose between Counts/keV or Counts/Channel
o Y-Axis Scale: options include square root, linear, or different log cycles. Note: this can 

also be changed using a scrolling wheel on an external mouse when focused on a 
displayed spectrum.

o Display: Bar Chart, Curve, or Histogram
o Grid: choose what type of grid, if any, should appear on the spectrum
o Smoothing: the spectrum can be smoothed in various ways including no smooth, display 

only 1024 channels, apply a smooth function (energy %) or by peak width (FWHM)) 
o Default true time (s): data entry for live time to provide appropriate statistics for 

generated or computed spectra
 Show Peak List: displays a list of peaks that can be overlaid on the spectrum; by selecting an 

entry, all peaks from the specified source and threshold will be displayed (this option is discussed 
in more detail in Section 7.1).

 Show Isotope DB: displays the Isotope Database for use in analyzing displayed spectra 
(discussed in Section 9.1.2)

4.2.3 Plot Display Screen View Menu

The View menu allows users to display common features of a plot using the cursor. When users select 
any of Single Escape, Double Escape, or Compton Edge, the cursor location on the spectrum is used as a 
starting point and energies of the specific features are calculated and displayed on the screen (Figure 18).
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Figure 18: Spectral Features Can be Viewed Using the View Menu

4.3 Source Wizard and Computed Spectra

Besides displaying measured spectra, GADRAS-DRF can also display computed spectra or isotope 
source spectra. Sources for computed spectra are entered on the Source for Computed Spectrum entry 
at the bottom of the Plot tab or by using the Source Wizard button. 

4.3.1 Source Wizard

The Source Wizard button shown in Figure 15 is located just below the Source for Computed 
Spectrum entry. The Source Wizard form is shown in Figure 19.
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Figure 19: Source Wizard Screen.

The drop-down menu in the source wizard allows users to select various types of sources, such as 
radionuclides and distributed GAM files. Users can use the arrows in the center of the window to add or 
remove sources from the current list of Included Sources. The third column on the far right of the Source 
Wizard allows users to edit the GADRAS-DRF shorthand notation for shielding, translation, and rotation 
of sources. After clicking OK, the Source Wizard will automatically generate the GADRAS-DRF 
shorthand string in the Computed Spectrum text box.

4.3.2 Computed Source Line

In lieu of using the source wizard button, the user can enter source information on the computed source 
line.

Sources may include:

 the name/serial number of a calibration source in the source library/database, 
 distributed GAM files, and
 an isotopic designation and source strength (e.g., 232U, 1.5uC). 

Activity units for the computed spectrum are always given in Curies (shortened to “C” instead of the 
standard “Ci”). This unit may be prepended with the following SI prefixes (Note: these are not case 
sensitive):

 pC: picoCuries
 nC: nanoCuries
 uC: microCuries
 mC: milliCuries
 kC: kiloCuries
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Alternatively, Becquerel units can be input using the following SI prefixes (also not case sensitive): 

 kBq: kiloBecquerel
 MBq: megaBecquerel
 GBq: gigaBecquerel

Mass or activity of a source can be specified and used for plotting. The mass is converted to the proper 
activity prior to plotting (e.g., 239Pu, 50g is converted to 239Pu, 3.1C). 

When GAM files are used, the activity level specified in Curies determines the scaling factor for the 
source. Thus, an activity of “1C” indicates that the source should not be scaled, and an activity of “2C” 
indicates that the source strength should be doubled.

The simulated/computed spectrum can be a mixture or sum of several spectra. The individual spectra can 
be summed by placing a plus (+) sign between the successive sources (e.g., 232U, 1uC+40K, 25mC). 
Gamma-rays emitted by the specified isotopes are folded through the detector response function to 
compute the spectrum that would be recorded if the detector were exposed to the given sources. If one 
spectral pair is plotted, the reduced χ2 fit residuals between the measured and computed spectra are 
calculated and displayed. 

4.3.3 Viewing Spectra

Figure 20 shows the Plot tab with a 88Y spectrum (cal.pcf, 3) on the foreground line and a background 
spectrum (cal.pcf, 1) on the background line. The Source for Computed Spectrum line shows that the 
measured spectrum is to be compared with the computed spectrum for the 88Y source with serial number 
495182 entered as 88Y_495182. 
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Figure 20: The Plot Tab Displaying Selections for a Foreground, Background, and 
Computed Spectrum.

Figure 21 is generated after the Plot button is clicked. The measured 88Y spectrum (background 
subtracted) is displayed in black, while the computed spectrum for the 88Y source (ID number: 495182) 
from the source library is displayed in red. The count rate is displayed at the bottom left of the graph for 
all graphed spectra for the displayed energy region. The count rates are color coded to match the color of 
the corresponding spectrum. 
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Figure 21: Plot of a Measured 88Y Spectrum (background subtracted) and the Computed 
Spectrum from 88Y Calibration Source.

Computed sources may be plotted by themselves by using the Source for Computed Spectrum line 
without a measured spectra on the foreground or background lines. If desired, effects of shielding 
materials can be estimated by specifying the material on the Source for Computed Spectrum line. The 
atomic number and areal density of the absorbing material can also be entered on the input line using the 
following convention:

232U,10uCi {26,10} + 137Cs,3.2mCi {13,5}In this example, 10uCi of 232U is propagated through 10 
g/cm2 of iron (Z=26), and 3.2mCi of 137Cs is propagated through 5 g/cm2 of aluminum (Z=13). This 
functionality is also accessible from the Source Wizard form, described in Section 4.3.
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5 COUPLING GADRAS-DRF TO EXTERNAL RADIATION 
TRANSPORT CODES

To accurately model non-point sources or sources in complex scattering environments using GADRAS-
DRF, an external code must be used to perform the radiation transport calculations. Radiation transport 
codes such as the Monte Carlo N-Particle (MCNP) code, developed by Los Alamos National Laboratory, 
can be used to model sources and scattering environments. The output from these codes can be used with 
the detector response function in GADRAS-DRF to model 3-dimensional sources or complex scattering 
environments. This section describes how users should set up the radiation transport codes (specifically 
MCNP) to use with GADRAS-DRF. Users may also elect to use other codes such as GEANT, PARTISN, 
DENOVO, or custom user codes.

GADRAS-DRF calculates the detector response for radiation directly incident on the detector as well as 
for radiation that has scattered in the environment before interacting with the detector. To calculate the 
scattered radiation, GADRAS-DRF has several scatter parameters which simulate a general scattering 
environment. If the scattering environment is complex, external transport codes can be used to calculate 
the incident radiation instead of GADRAS-DRF. To do this, MCNP should be used to model the radiation 
current separately on multiple facets of the detector. Using the MCNP results, GADRAS-DRF can 
compute gamma-ray spectra and neutron count rates for a given scenario. These results may have a higher 
degree of fidelity than can be obtained by applying the default scatter parameters. If a source cannot be 
approximated with a point source, MCNP can be used to calculate the radiation transport from the source 
to the detector with a higher degree of fidelity than GADRAS-DRF alone.

The MCNP scenario should be designed to simulate the external scattering environment and tally the 
energy-dependent current on each surface of the modeled detector. The output files should then be 
converted into files that are compatible with GADRAS-DRF. These input files are called “multi-faceted 
GAM files.” GADRAS-DRF processes these multi-faceted GAM files by calculating the detector 
response from the radiation that scatters within the detector housing, and assuming that MCNP has 
accounted for the external radiation scattering.

To correctly process multi-faceted data generated by MCNP, users need to suppress GADRAS-DRF’s 
external scatter radiation calculations by setting all of the scatter parameters to zero (Figure 22). The 
radiation transport code must tally photons and neutrons that scatter into the detector from the floor, 
walls, ceiling and any other object in the detector’s vicinity; GADRAS-DRF will account for radiation 
scatter within the detector.
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Figure 22: Set all Scatter Parameters to 0 When Using Multi-faceted GAM Files.

 
5.1 MCNP Methodology

To compute the detector surface currents for a given scenario, the MCNP model should contain a 
cylindrical volume representing the detector. The cylinder should be positioned at the detector location 
with dimensions similar to those of the detector. The current tally (F1) should be used to tally the photons 
and neutrons that cross each individual surface (front, back, sides). The pulse-height tally (F8) is not 
appropriate for use with GADRAS-DRF, as this tally represents the detector response function generated 
by MCNP and cannot be readily converted to a format that is usable by GADRAS-DRF. The current tally 
should be generated with the energy bin structure provided with the GADRAS-DRF distribution in the 
“MCNPbins.dat” file, (energies in this file must be converted from keV to MeV for usage in MCNP). 
Figure 23 below shows a simple example of a 127Cs source 1 meter away in air. A photon importance of 
zero in the detector cell ensures that the tally does not double-count particles that pass through the 
detector volume.
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Simple Example Input Deck
1 0 -1 imp:p=0 $ detector volume
2 1 -0.0012 -2 1 imp:p=1 $ surrounding air
3 0 2 imp:p=0

1 rcc 100 0 0  10 0 0  10 $ detector surfaces
2 so 1000 $ universe sphere

mode p
sdef par=p pos=0 0 0 erg=0.6617
m1   7014 -75 $ air
     8016 -25
f1:p 1.1  $ side of cylinder, side of detector
f11:p 1.2 $ bottom of cylinder, front face of detector
f21:p 1.3 $ top of cylinder, back face of detector
e0 {insert values from MCNPbins.dat}

Figure 23: A Simple MCNP Input Deck.

The MCNP output file needs to be converted into a format usable by GADRAS-DRF. The tally from 
MCNP should be converted into surface current density (particles/m2s) for each energy bin. To do this, 
the source activity, particles per decay, and detector facet surface areas must be known. Figure 24 below 
shows an example of the necessary unit conversion for a 1 uCi 137Cs source counted with a cylindrical 
detector (r=10cm, l=10cm). Once converted to the appropriate units (particles/m2s), the current densities 
can be incorporated into the GADRAS-DRF multi-faceted GAM file. 

Figure 24: Pseudo-code for Scaling MCNP Surface Current Outputs to Units Suitable for 
use with GADRAS-DRF.

Figure 25 below shows an example of a multi-faceted GAM file with current densities for the three facets 
of a detector. GADRAS-DRF represents detectors as if they are symmetric normal to the detector axis, so 
there is no distinction between the top, bottom, left, and right sides. The average current over all the 
lateral sides of the detector should be specified as the third parameter on each line.
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Format specification (5 
signifies multi-faceted 
current data)

0 discrete photons 
(always);
 1,475 photon groups; 
78 neutrons groups

Energy (keV-
photons, eV-
neutrons) at 
lower (photon) 
or upper 
(neutron) 
bound of 
energy group

Current density 
(particles/s/m2) 
incident on front 
surface

Avg. current 
density incident 
on side surfaces

Current density 
incident on back 
surface

Figure 25: Multi-faceted GAM File Example

In Figure 25 above there are NG + 1 lines for the photon groups and NN + 1 lines for the neutron groups 
where NG and NN are the number of photon and neutron groups respectively. For multi-faceted GAM 
files, there are always 0 discrete photons specified. The leakage values are specified in units of inbound 
current density (particles/m2s, current divided by surface area) on each detector surface. GADRAS-DRF 
accounts for the surface area of each detector facet when the response function is computed for a given 
detector. As a result, the same GAM file may be used to compute a response function for a different 
detector if it is situated at the same height and distance to a radiation source.

The multi-faceted GAM file should be saved as <filename>.GAM, where <filename> is the user’s 
chosen file name. This file can then be included on the computed source line for plotting.

Last photon group

First neutron group
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5.2 Automatic Conversion from MCNP Output to GADRAS-DRF Input

GADRAS-DRF is distributed with python scripts that will convert MCNP output files into GADRAS-
DRF input files. These scripts are located in the GADRAS-DRF data folder (usually C:\GADRAS-DRF), 
and are called “mfgf.py” and “mcnpfunc.py”. Users can view and modify “mcnp_example.py” to use 
these scripts properly. Currently only photons are included in the mcnp_example.py file.

To use these scripts, the MCNP model must be configured to create a MCTAL file as part of its output. 
To do this, the line “PRDMP J J -1” must be included in the data card of the MCNP file. The python 
scripts need several inputs to properly generate a multi-faceted GAM file for use with GADRAS-DRF. 
Users must supply:

 MCNP MCTAL file
 Source activity (in Bq)
 Source yield (particles per decay)
 Area of face of detector in MCNP model (in m2)
 Area of side of detector in MCNP model (in m2)

Users must also install python on their computer and make sure the numpy library is present. To run the 
script, users should type “python mcnp_example.py” into the command prompt.
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6 SPECTRUM ENERGY CALIBRATION

To aid in performing an energy calibration or in determining a peak’s energy in a spectrum, the 
PhotoPeak List library can be used. This list can be accessed from the Tools tab or using the mouse 
(shift+left mouse click (holding down the shift key while clicking the left mouse button)) on a peak of 
interest in a displayed spectrum. 

The PhotoPeak List library is shown in Figure 26. The blue highlighted entry corresponds to the gamma-
ray automatically selected by GADRAS-DRF based on its proximity to the selected energy location on 
the current plot (shift-left click location). The selection also takes into account the relative importance of 
the gamma-ray to the observable spectral features. 

Figure 26: PhotoPeak List Library with the 88Y Entry Blue Higlighted and Both Overlay 
Options Boxes are Checked.

At the top left of the PhotoPeak List library screen are two check boxes for overlay options. The overlay 
fit check box when selected will generate a spectral overlay fit for the selected isotope (a single regression 
fit using one isotope). The spectral overlay displays the source activity and shielding configuration 
estimated to provide the best fit to the measured spectrum. The overlay lines check box overlays vertical 
lines at the appropriate energy locations for the selected isotope on the measured spectrum utilizing the 
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Max Lines to Plot selection. The displayed overlay can be changed to display another isotope simply by 
selecting and highlighting another gamma-ray line in the PhotoPeak List, allowing for rapid examination 
of many isotopes in the library. The color and line thickness of the overlaid spectrum can be changed 
using the options at the top of the library window. The selections displayed in the PhotoPeak List in 
Figure 26 are shown in the displayed graph in Figure 27.

Figure 27: Graph Displays the Measured 88Y Spectrum (black) with Both Overlay Options.

The graph in Figure 27 displays the measured 88Y spectrum (black) along with both overlay options. The 
overlay fit option generates a spectrum which is cyan in color and has a thickness value of three. The 
overlay lines option displays the lines and their energies. 

6.1 Automatic Energy Calibration using GADRAS-DRF

Spectra can be calibrated automatically from the Detector tab or the Plot tab on the main window. The 
Calibrate drop-down contains the Automatic Calibration (ecal and resolution) option. This option takes 
a single SpecPair as its input and estimates the energy range, resolution, and some peak shape parameters 
based on the spectrum. This quick method of calibrating a spectrum should not be used for detailed 
analysis.

6.2 Manual Energy Calibration using GADRAS-DRF

Spectra can be calibrated manually from the Detector tab or the Plot tab on the main window. The 
Calibrate drop-down list contains the Peak Search and Manual Energy Calibration option as shown in 
Figure 28. 
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Figure 28: Peak Search and Manual Energy Calibration is Located in the Detector Tab.

By selecting this option, the Peak Search and Manual Energy Calibration form appears with the Peak 
Selection and Identification tab selected (shown in Figure 29, left). To show a list of available spectra, a 
PCF file should by loaded by selecting Open Spectrum File in the File dropdown menu. A user can then 
drag and drop a record (row) from the PCF table into the blank portion of the Peak Search window. The 
zooming functionality on this plot is similar to the mechanism for normal plots. Users can click-and-drag 
over regions of interest to zoom in. To zoom out, users can right-click on the spectrum. To include a peak 
in the fitting routine, the user should click a visible peak in the displayed spectrum. Peaks recognizable by 
GADRAS-DRF for this procedure are shown in red above a cyan continuum with the default 5 sigma 
peak threshold, as shown in Figure 29 (right).
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Figure 29: The Peak Search and Manual Calibration Screen is Blank When First Opened 
(left) and Populated When a Spectrum is Loaded (right).

The Peak Threshold (sigmas) option can either be lowered to recognize additional peaks or raised to 
recognize fewer peaks. For the new peak threshold value to take effect, it may be necessary to reload the 
spectrum by dragging the file to the window. The selection of a recognized peak will open a window for 
setting the energy of the peak as shown in Figure 30. If the centroid energy is close to a known peak for 
an isotope included in the GADRAS-DRF library, the isotope will be displayed along with the determined 
gamma-ray energy. Other peaks and energies around the determined value are also listed. The initial peak 
energies are based on the current energy calibration parameters existing for the detector. Users may select 
the appropriate isotope and energy in the provided list, or they may manually enter the appropriate energy 
for the isotope. Clicking OK assigns the Actual Energy selected to the channel number in the spectrum. 
This process can be repeated for any number of available peaks in the measured spectrum as needed to 
complete the channel/energy table. 

Figure 30: Users Select the Energy of the Peak From the Popup Window, or may 
Manually enter the Known Energy.

For high-precision spectra (e.g., HPGe spectra), a region of interest (ROI) of the graph can be selected by 
left-clicking and dragging over the ROI. A right-click will zoom out the display. Individual peaks may be 
easier to identify and select in the new ROI. 

After entering an appropriate number of peaks in the channel/energy table, the energy parameter 
adjustment can be performed. The upper portion of Figure 31 displays the two energy peaks that were 
selected for energy calibration (channel/energy table) and the lower portion displays the Adjust 
Parameters tab. The highlighted (cyan) parameters will be adjusted. After the peak selection process is 
complete and the appropriate parameters are adjusted, the user should click the Fit Parameters button on 
the bottom of the window to initiate the least squares fit to the data. 
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Figure 31: Energy Calibration Screen Showing the Selected Peaks and the Highlighted 
(cyan) Parameters that will be Adjusted (center).

To ensure a proper energy calibration, a small subset of well-known peaks should be selected. GADRAS-
DRF will then properly assign energies for subsequent peak selection.

It is usually advisable to use Order 0 and Order 1 for an initial energy calibration, and then to include 
higher orders if the fits are not acceptable. The Order 1 energy parameter should be approximately equal 
to the full scale energy value of spectrum in keV (e.g., 1500, 3000, 11000) depending on the detector. 
Small values should be used for Order 0, 2, and 3 energy parameters because large values could lead to 
errors in other regions of the spectrum. Once the energy scale and gain (Order 0 and 1) parameters are 
adjusted correctly, the energy resolution parameters (low/high-E skew) can be adjusted. 

Figure 32 illustrates a properly calibrated measured spectrum for 137Cs. To examine the peak, the user can 
access the PhotoPeak List (shift-left mouse click) near the peak around 661 keV. Alternatively, if the 
isotope is known, the Isotope DB form can be accessed. As shown in Figure 32, the measured spectrum 
corresponds with the library spectrum overlay (the computed peaks match well with the measured data). 
The legend on the graph (lower left) states the isotope, the activity, and the shielding configuration that 
best fits the measured spectrum
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Figure 32: A Measured Spectrum (black) with a 137Cs Library Spectrum Overlay (cyan).

6.3 Graphical Energy Calibration

A graphical calibration method is an alternative to using the Peak Search and Manual Energy Calibration 
process. This can be used for the adjustment of the gain and offset (Order 0 and Order 1) of the 
spectrum. The calibration will occur using a graph of the measured spectrum and the appropriate overlaid 
spectrum from the PhotoPeak list or Isotope DB library. Figure 33 shows a measured 137Cs spectrum 
(black) and a library 137Cs spectrum (red) where the 137Cs peak at 661 keV in the measured spectrum does 
not coincide with the energy of the library peak. This implies that an energy calibration of the data 
(measured spectrum) is needed. 
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Figure 33: Energy Calibration is not Correct for Displayed Spectrum.

In this example, to calibrate the measured spectrum correctly, the centroid of the measured peak (black) 
should be adjusted to match the centroid of the computed spectrum (red). To make this adjustment, the 
user should right-click on the peak in the measured spectrum and drag the peak to the correct energy (the 
centroid of the peak in the computed spectrum). Once this action has been performed, the energy 
calibration window shown in Figure 34 will appear for the selection of the appropriate calibration 
parameter (offset or gain). The user will need to confirm the adjustment before the energy calibration 
parameter will be changed.

Figure 34: Energy Calibration Parameter Selection and Confirmation Window.
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Due to the potential for inadvertent changes to calibration parameters, GADRAS-DRF requests 
confirmation for the parameters to be adjusted when the dragging operation is used (unless another 
graphical calibration adjustment has been performed within one minute). 

The graphical calibration compensates for high-order energy calibration parameters so that the graphic 
adjustment is accurate regardless of non-linear energy calibration parameter settings. Figure 35 displays 
the successful completion of the graphical energy calibration for the measured 137Cs spectrum to the 
computed spectrum.

Figure 35: Sucessful Graphical Energy Calibration.
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7 ANALYZING SPECTRA

7.1 Graphical Analysis Using Plot Overlays from Library 

The GADRAS-DRF plotting menu allows for some preliminary spectral analysis. This graphical 
capability facilitates the comparison of selected peaks and energies in a measured spectrum with library 
spectra from the Isotope DB or the PhotoPeak List (shift+left mouse click). 

The left side of Figure 36 shows an example where the PhotoPeak List form is used to overlay a 
computed spectrum for 88Y (cyan) with the measured spectrum. This display is presented after 
shift+clicking on the 898 keV peak. The activity of 88Y in this sample is estimated to be 5.13 uCi with no 
shielding. The PhotoPeak list is shown on the right side of Figure 36. If the overlay does not match, 
another peak may be chosen for comparison with the measured spectrum.

Figure 36: Graph of Measured Spectrum with Overlay (left); Photopeak List with 
Displayed Isotope Highlighted (right).

7.2 Numerical Spectral Analysis

GADRAS-DRF is specifically designed to perform robust full-spectrum analysis. Once a detector 
calibration has been performed, various analysis techniques can be used to identify peaks and perform an 
analysis. The Analyze tab on the main window provides options for numerical analysis options. The 
analysis options available are: 

 Single Regression
 Multiple Regression
 ComputeFlux
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The Analyze tab shown in Figure 37 contains text boxes that accept input for foreground and background 
spectra similar to the Plot tab. Display options for the analysis output are located on the right side of the 
Analysis tab. The ensuing plot will only subtract the background if the Strip background option is 
selected. 

Figure 37: The Analyze Tab on the Main Form.

7.2.1 Source Libraries

Several source libraries are generally available for inclusion in any numerical analysis, as shown above in 
the large box labeled Source Libraries (Figure 37). 

The available source libraries: 

 Isotope
 Xray
 Benchmark
 CaptureGammas
 Continuum
 Neutron
 SNM
 DetectorFolder
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Other libraries can be created and included by individual users. This is done by creating new directories 
under GADRAS-DRF\Source. Each library/directory contains a series of files that defines emission rates 
of gamma-rays or neutrons. Files with the extension ISO in the Isotope directory define discrete gamma-
rays emitted by unshielded isotopic sources. 

Within each library are lists of sources that can be selected for use in the current analysis by clicking on 
the individual source designator. The selected sources are then available for analysis. Multiple Regression 
analysis allows for multiple libraries to be utilized.

The most commonly used library in a typical analysis is the Isotope library. Figure 38 shows the Isotope 
library window with several of the isotopic sources selected and highlighted (blue). Users may select 
various groups of isotopes in the Group Selection Options portion of the window. The group selection of 
isotopes carries no guarantee of accuracy or completeness; it is provided only to save time in selecting 
such isotopic groups. These groups include:

 Fission – fission daughter products
 Natural –naturally occurring isotopes
 Medical –typical isotopes used as radiopharmaceuticals and sources for imaging and therapeutic 

use
 Calibration – isotopes often used as laboratory calibration sources
 SNM – isotopes typical of uranium and plutonium
 Automatic – automatically chooses potential isotopes from the library based on a simple peak 

identification algorithm 

Figure 38: Isotope Library Window.

Fitting the continuum caused by the presence of a neutron source cannot be done by selecting a neutron 
emitter (e.g., 252Cf) out of the gamma-ray Isotope library. Instead, it must be done with an appropriate 
selection from the Neutron library. 
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7.2.2 Introduction to Linear Regression Analysis

GADRAS-DRF contains two routines used to analyze gamma-ray spectra by linear regression. The two 
programs, located on the Analysis screen have the same user interface and analysis approach, but are used 
for different purposes. 

 Multiple Regression performs a similarity (chi-square, χ2) analysis with the assumption that 
several gamma-ray sources are contributing to a measurement. For example, in the case of a 
radioactive fallout measurement, several radionuclides will be present and should be included in 
the analysis. 

 Single Regression performs a similarity (chi-square, χ2) analysis to rank individual gamma-ray 
sources to a radiation measurement. This option should be used when it is anticipated that only 
one source heavily dominates the spectrum.

Both analysis routines report a χ2, which indicates the deviation between the measured and the calculated 
sets of data (relative to estimated uncertainties in the two sets). The value of χ2 should be near unity if the 
two data sets were produced by the same radioactive source(s). 

The spectrum to be analyzed is selected by dragging and dropping a foreground and background spectrum 
from the PCF record window (or by entering it manually). Multiple and Single Regression analyses 
attempt to fit the measured spectrum with selected source(s). Shielding parameters can be estimated to 
characterize effects associated with intervening materials. The shielding parameters describe intervening 
materials by an effective atomic number (AN) and areal density (AD). Selected isotopes are ranked for 
consistency with the measurements when Single Regression is performed and more than one isotope is 
selected. Multiple Regression finds the combination of selected isotopes and associated activities that 
gives the best fit to the spectrum. Parameters associated with intervening materials can be adjusted by 
clicking on the AN and AD labels (clicking these labels highlights the adjacent boxes, turning them cyan). 
There is also a check box for the option of allowing independent shielding for each radioactive source in 
the measured spectrum. 

7.2.2.1 Single Regression Analysis

The Single Regression option ranks individual gamma-ray sources for their similarity (χ2) to a radiation 
measurement. It is used when it is anticipated that one source heavily dominates the spectrum. Any 
combination of sources can be selected by the user from the available source libraries (see Section 7.2.1), 
Source Libraries, for description). Figure 39 shows the Single Regression tab with the selected sources 
from the available source libraries. To perform the analysis, click the Analyze button at the bottom right 
corner of the page.
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Figure 39: Single Regression Analysis Tab.

Single Regression analysis generates a single graph of the best fit data and a summary page. The best fit 
is plotted as shown in Figure 40, and the summary page (Figure 41) ranks the selected isotopes based on 
similarity to the measurement using the reduced chi-square (χ2).
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Figure 40: Single Regression Analysis Results of Unshielded 88Y Spectrum.

Figure 41: Single Regression Analysis Summary Page.

7.2.2.2 Multiple Regression Analysis

The Multiple Regression analysis algorithm finds the combination of sources that gives the best fit to the 
measured spectrum. A reverse regression technique is used in which a combination of all spectral 
templates is utilized. Subsequent iterations gradually remove sources that do not contribute to the fit. 
When performing this procedure, users have the option to allow an intervening, adjustable absorber/shield 
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to obtain the best fit. This is done by activating the boxes labeled AN and AD. Calculations can take 
several minutes if a large number of sources are selected, especially if the shielding is allowed to vary. 
Figure 42 shows the Multiple Regression tab.

The Multiple Regression analysis generates a single graph of the best fit data and a summary page. The 
graph will indicate the relative effects of each isotope in the overall fit if the Fill Templates option has 
been selected. The graph shown in Figure 43 displays each selected source’s contribution. The summary 
of the multiple regression analysis results shown in Figure 44 displays the analysis results in text form 
(isotope list, activities, weights, and shielding information). The text string found at the bottom of the 
summary page can be copied and pasted to the source line (Source for Computed Spectrum) on the Plot 
tab for plotting as an overlay for comparison with measured data.

Figure 42: Multiple Regression Analysis Tab.
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Figure 43: Multiple Regression Analysis Results of 88Y Spectrum.

Figure 44: Multiple Regression Analysis Summary Page.

7.2.3 Compute Flux

The ComputeFlux algorithm can be selected as shown in Figure 45. The ComputeFlux tool estimates 
the incident flux from the measured spectrum by performing nonlinear regression analysis. Prior to 
analysis, the user should select the appropriate spectral files for the foreground and background. A 
graphic plot of the results displays peak and continuum terms as shown in Figure 46. The flux profile is 
also saved in a file with a GAM extension. 
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Figure 45: ComputeFlux Analysis Tab.

Figure 46: Graph of ComputeFlux Showing the Peaks and Continuum From the Flux 
Calculation.



70



71

8 NEUTRON DETECTORS

The Neutron tab allows users to model neutron detectors. Neutron detector response information is stored 
in files named Neutron$XX.gadras, where “XX” is the name of the neutron detector. Neutron detector 
files must be stored in a gamma detector directory and thus be associated with a gamma detector. If a 
scenario arises in which no gamma detector was used, users must create a “dummy” gamma detector 
before they can access the Neutron tab. Doing this will not affect the neutron detector results. If no 
neutron detector is associated with the current gamma detector setup, the Neutron tab will look similar to 
Figure 47.

Figure 47: Neutron Tab without Selected Neutron Detector.

8.1 Creating a New Neutron Detector

Users can create a new neutron detector by clicking on the File menu, then Create New Neutron 
Detector. A new form will appear prompting the user to input parameters to create a new neutron detector 
(Figure 48). Users must enter a name for the detector, the source-to-detector distance in cm, and the 
height of the detector in cm. Users may then either choose to clone a common detector, clone an existing 
detector, or create a new detector from known parameters.
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Figure 48: Create New Neutron Detector Form.

To clone a common detector, users can select a detector from the drop-down list and click Clone. To copy 
an existing detector, users can click Browse and navigate to the existing detector file 
(Neutron$*.gadras). This detector file can be in another directory. This is useful when the same neutron 
detector is used with multiple gamma detectors.

To create a detector from existing parameters, fill out the bottom portion of the form (Figure 48). The 
required parameters are:

 Moderator Area (cm^2): the surface area of the moderator surrounding the detector as seen by 
the source

 Front PE Thickness (cm): the thickness of polyethylene in front of the detector as seen by the 
source

 Back PE Thickness (cm): the thickness of polyethylene behind the detector as seen by the source
 Eff. Enhancement: used to resolve differences between observed and computed efficiencies
 Cadmium Cover: checked if the detector is surrounded by cadmium

After specifying the parameters, click the Create button to create a new neutron detector.

8.2 Neutron Detector Characterization

After creating a neutron detector, the parameters on the Neutron tab are activated and the initial settings 
are filled in. Users can then fill in more information about the measurement environment and neutron 
detector. The first drop-down menu describes the overall scattering environment for the measurement. 
The following options are available:
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 No reflected neutrons: the environment does not scatter any neutrons into the detector
 Outside or large bay: the environment scatters neutrons only from the floor
 Inside above suspended floor: neutrons are scattered from the walls and floor; the floor is 

assumed to be above ground and fairly thin
 Inside above concrete on ground: neutrons are scattered from the walls and floor; the floor is 

assumed to be infinitely thick

The following parameters should be filled in before attempting to characterize the detector:

 Distance (cm): The distance from the source to the detector face; the setback of the neutron 
detector element should also be specified after the “+”

 Height Above Floor (cm): the height of the detector above the floor
 Moderator Height (cm): the vertical height of the moderator
 Moderator Width (cm): the horizontal width of the moderator
 Thermal Cutoff Back and Sides: the energy at which neutron are killed if they enter from the 

back or sides of the detector housing
 Detector Neutron Lifetime (μs): the lifetime of the neutron in the detector
 % Covered by Cadmium: percent of the detector covered by cadmium

Once the parameters are filled in, characterization measurements using 252Cf should be recorded. The 
calibration source should be in the source database (see Section 9.1.4). The name of the source is 
252CF_serialNumber where serialNumber is the identifying serial number of the 252Cf source. The date 
of the measurements should be recorded. Once this information is present, GADRAS_DRF will calculate 
the activity of the source during the measurements and display the information in the corresponding 
textbox.

A range of moderated 252CF sources is required for GADRAS-DRF to determine the proper energy-
dependent response function of the neutron detector. Measurement information for each moderated 
sources is recorded in the table on the bottom of the form. The source configuration can be selected from 
the following:

 Background: measurement taken with no source
 Cf252-Bare: measurement taken with bare 252Cf source (no shielding or moderator on source)
 Cf252-XXcm-PE: measurement taken with XX cm of polyethylene surrounding the source
 Cf252-XXcm-BPE: measurement taken with XX cm of borated polyethylene surrounding the 

source

For each measurement, the Live Time and the total number of counts should be recorded in the table. The 
net count rate will be computed automatically. The computed count rate will be computed based on the 
parameters entered in the form.  The Neutron Background button will bring up the Neutron Background 
form (Figure 49). This form determines the cosmic flux that can be expected during the count. Users can 
select a pre-defined location from the dropdown list, or they can input the latitude, longitude, and 
elevation themselves. Users should specify whether the experiment was taken in a building below 
multiple floors, or they can specify the areal density themselves. The reference date can be changed to 
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match when the measurement was taken. As a reference, the cosmic neutron rate relative to the average 
rate New York City is given.

Figure 49: Neutron Background Form.

The Adjustable Parameters groupbox holds parameters that can be optimized to improve the neutron 
detector model. By clicking the label of the adjustable parameter, users can specify whether they want the 
parameter to be adjusted. By clicking the Fit button, GADRAS-DRF will optimize the cyan colored 
parameters using an iterative non-linear regression algorithm. The computed count rate in the 
measurement table will be updated with the optimized parameters. Clicking the Clear button will reset all 
of the parameters on the form.

8.3 Neutron Response

The response function of the neutron detector can be seen in the Response tab. Users can see the 
efficiency of the detector for different neutron energies or the detector response for a source. Users can 
specify the measurement environment, the distance, and the height for the measurement. Users have two 
options for the y-axis – log10(Energy * Differental flux) or log10(Neutrons / eV / s). If the user specifies 
a source, the blue spectrum corresponding to the detector response for the source will be populated in the 
graph. The source neutron leakage and multiplication fields will be populated, as well as the detector 
count rate and efficiency fields.
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Figure 50: Neutron Response Tab.
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9 GADRAS-DRF TOOLS

9.1 GADRAS-DRF Editors and Libraries

Editors for various libraries and properties can be found under the Tools menu option on the main 
window, as shown in Figure 51. Editor options include:

 Deviation Pairs
 Isotope DB (Isotope database)
 PhotoPeak List (discussed in Section 6 – Energy Calibration) 
 Source DB (Source database)

Figure 51: Tools Tab.

9.1.1 Deviation Pairs

The Deviation Pairs Editor form is accessed from the Tools tab on the main window. This option allows 
users to edit and view deviation pairs for the current detector.

Deviation pairs are used when performing energy calibrations on non-linear detectors. An example of the 
Deviation Pairs Editor is shown in Figure 52. The source-detector distance is shown for reference in the 
upper right corner of the form. The Detector ID is used when an array of detectors is using the same 
detector response function parameters (separate deviation pairs can be specified for each detector in the 
array). Deviation pairs are specified with a known energy (left column) and the observed deviation (right 
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column), both in units of keV. Deviation pairs are specified by first setting anchor points with deviations 
of 0 (239 and 2614 keV in Figure 52), then specifying other known deviation pairs. GADRAS-DRF can 
use a total of 20 deviation pairs. A further explanation of deviation pairs can be found in Reference [8], 
and should only be used by advanced users.

Figure 52: Deviation Pairs Editor.

9.1.2 Isotope Database (DB)

The Isotope DB form is accessed from the Tools tab on the main window. This option allows users to 
select and view gamma-ray peak energies and yields for selected isotopes in the library. 

Figure 53 shows the Isotope DB form populated with information for 7Be. The drop-down list at the top-
left corner of the window allows users to select an isotope. The graph in the center of the form shows the 
locations of the main photopeaks for the selected isotope. The center of the window displays properties 
for the selected isotope such as isotope designation, half-life, age, and specific activity. It also specifies if 
the nuclide is assumed to be in prompt or secular equilibrium with its daughters. The bottom of the 
window displays characteristic gamma-ray energies sorted by intensity multiplied by the square-root of 
the energy.
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Figure 53: Isotope DB Tool Displaying 7Be Isotopic Information.

If a spectrum has been plotted, users can display overlays of the nuclide on a current plot using the two 
Overlay checkboxes located at the top of the Isotope DB form. The first checkbox overlays a graphical 
fit of the selected isotope by automatically calculating the activity and shielding to best match the 
measured spectrum. The overlaid spectrum is generated using the detector response function parameters 
found in the Detector.dat file. The user may also change the color and line thickness of the overlaid fit. 
The second checkbox overlays vertical lines on the plotted spectrum, which correspond to the major 
energy lines of the selected isotope. The number of lines to display can be changed by the user.

GADRAS-DRF developers commonly list gamma-ray emissions from daughter radionuclides in the 
gamma-ray emission list for the parent radionuclide. This generally occurs if the daughter radionuclide is 
traditionally observed to be in equilibrium with the parent. For example, gamma-ray emissions arising 
from the decay of 208Tl are also listed under 232Th. The origin of a gamma-ray can be observed in the 
Source column of the table.

9.1.3 PhotoPeak List

The PhotoPeak List form is described in Section 6.

9.1.4 (Calibrated) Source Database (DB)

 Users can access the Source DB form from the Tools tab on the main window. This form 
displays a database of known calibration sources with various properties. The source list is 
located in the Source.lib file in the root GADRAS-DRF directory. When GADRAS-DRF is 
updated to a new version, user-added sources are automatically retained. Sources are added and 
identified according to their unique Source ID.
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Source DB includes the following information for each calibration source:

 Source ID —Naming convention: atomic weight followed by the elemental symbol (e.g., 109Cd) 
+ underscore + alphanumeric information (i.e., serial number or other identifying information). 

 Original Calibrated Activity 
 Original Calibration Date 
 Location 

Calibration sources are grouped by radionuclide on the Source DB form. Clicking the tree-expand button 
(the + to the left of each isotope name) allows the user to view all calibration sources for that 
radionuclide. Users may edit or delete existing sources or add new sources using this form. 

When computed spectra are compared with measurements, activities for stored calibration sources are 
decay-corrected based on the Calibration Date, the Calibrated Activity, and the measurement date of 
the plotted spectrum. An activity calculator is provided at the bottom of the window for users to obtain 
decay-corrected activities for each source. Figure 54 illustrates a listing of calibration sources for 109Cd 
and the activity calculator.

 

Figure 54: Source DB Tool with a 109Cd Source Highlighted.

9.2 Calculators

9.2.1 Dose Calculation 

The expected dose (exposure) rate from almost any source can be calculated using GADRAS-DRF. Note: 
this calculation is independent of detector characteristics and any internal or external shielding. However, 
GADRAS-DRF does compensate for attenuation and scattering by intervening air. Based on methods 
specified in ANSI/ANS‐6.1.1‐1991, “Neutron and Gamma‐Ray Fluence‐to‐Dose Factors,” effective 
dose equivalent rates for an anthropomorphic representation of the human body can be calculated. 
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The Dose Calc button is located under the Tools tab on the main form. The radionuclide source strength 
can be provided as activity (Curies) or mass (grams). Information needed for a dose calculation includes 
the following:

 Preferred dose units: Select output units via drop-down menu (Rem or Sievert) 
 Source (radionuclide and source strength): Radioactive source information (e.g., “137Cs, 

100uC”; a known source from Source DB; or a model file name)
 Distance: source-to-detector distance (cm). 
 Gamma Energy Threshold (optional): any gamma emissions below the specified threshold 

energy (keV) are excluded when the gross leakage is tallied (Note: this only affects the gross 
leakage, not the computed dose).

The following calculated rates are shown in Figure 55:

 Gamma Dose 
 Neutron Dose 
 Total Dose
 Gross Leakage (gamma) 
 Gross Leakage (neutron) 

Figure 55: Dose Calculation Tool.

9.2.2 Distance Calculator

The distance calculator uses dose rates taken at two different positions to estimate the distance to the 
source. This can be useful if the source is inside a large container and the exact position is unknown. This 
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form uses ratios of dose rates and distances, so units are arbitrary as long as they are consistent. An 
example of the form can be seen in Figure 56.

Figure 56: Distance Calculator Tool.

The Distance from Ref. Pt. should be entered as a distance from a consistent position that is in line with 
the source (i.e. the source and the two measurements should form a line and the distances should be 
entered from an arbitrary point on the line). One caveat is that if the source is not in line with the two 
measurement points, the resulting position may not be accurate.

The scatter environment can impact the dose rate measurements. Because of this, the distance calculator 
gives users the option to estimate the scatter environment. Most of the time, users should use the Mid 
Scatter option (Power Law: 1.85). Low Scatter (Power Law: 2.0) should be used when the floor is very 
thin or non-existent and there are no walls nearby. High Scatter (Power Law: 1.65) should be used when 
the measurement is taken in a compact area, such as a vehicle. Users also have the option of specifying 
their own Power Law if this value is known.

9.3 Other Tools

9.3.1 Rebin Tool

The rebin tool creates a file called Rebin.dat for a particular detector. This tool should be used when users 
want to rebin a spectrum into a specific energy bin structure. The form can be seen in Figure 57.
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Figure 57: Rebin Tool.

The Minimum Energy should be the energy of the low edge of channel 0. Maximum Energy should be 
the energy of the upper edge of the maximum channel. The Energy Power and Zero Intercept fields are 
used to determine the bin width as a function of energy. To have uniform bins in the continuum, the 
Energy Power should be 0. The bin width will be determined by the minimum and maximum energies, 
as well as the number of channels. In Figure 57, the bin width will increase as the square root of the 
energy, and the channel corresponding to 0 keV will have a bin width of 1 keV.

Users may define the number of channels in two ways. By selecting the Number of Channels option, 
users can define the total number of channels to use. The continuum and peaks will have the same binning 
structure. If Continuum Resolution is selected, users can specify separate bin widths for the continuum 
and the peaks. The Continuum Resolution textbox defines the bin width as a percentage of energy at 661 
keV. The bin width  (keV) for the continuum is determined usingΔE

,ΔE = C1 - pEp + E0

where  is the bin lower energy bound in keV,  is the Continuum Resolution (at 661 keV) in keV,  is E C p

the Energy Power,  is the Zero Intercept in keV. For example, in Figure 57, the Zero Intercept is 1 E0

keV, the Energy Power is 0.5, and the Continuum Resolution is 3%. Therefore, at 1000 keV, the bin 
width is 25.4 keV. By default, the continuum resolution is also used for energy bins containing peaks. If 
the “Narrow bins around peaks defined in Photon.lis” checkbox is checked, users can define a different 
bin structure around peaks. Photon.lis is stored in the root GADRAS-DRF data directory (default is 
C:\GADRAS-DRF) and is universal for all detectors. Users can modify this file to include peaks they 
wish to have more bins in or remove peaks they wish to ignore. An example of the Photon.lis file can be 
seen in Figure 58.
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Figure 58: Photon.lis File.

To modify this file, users can input the energy in the first column, the nuclide name in the second column, 
the absolute yield (%) in the third column, and the detectability (based on energy and yield) in the fourth 
column. The Rebin tool only reads the first column; the rest of the columns are ignored. Only peaks 
within the specified energy range will be used. The default file is sorted by energy, but users may input 
peaks in any order. Users may select a constant bin width for peaks, or may use the percent of the peak’s 
energy as the bin width basis. The Rebin tool will assign one bin to the peak with a width corresponding 
to the specified energy or percentage of peak energy. If the annihilation peak at 511 keV is specified, the 
bin width is extended by 3 keV due to Doppler broadening of the peak.

Once the parameters are filled in, users can click the Generate Data button to create the Rebin.dat file. 
The information textbox will be populated (Figure 59). The number of channels will be displayed first, 
followed by the energy bins. This information is recorded in Rebin.dat. When the Rebin.dat file is 
present in the detector directory, the Rebin checkbox on the Detector tab will be enabled. Users can 
choose whether they want the plotted spectrum to be rebinned according to the Rebin.dat file by 
checking this box.
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Figure 59: Rebin Data Tool with Data Generated.

9.3.2 Batch Peak Search

Users can perform a peak search on multiple files by using the Batch Peak Search tool (Figure 60). 
Users can select which files they want to analyze using the Filter textbox. In Figure 60, all files in the 
current detector directory ending in .pcf will be analyzed. The Threshold (Sigmas) textbox defines how 
far above the continuum a peak must be to be included in the results. After the files are chosen and the 
threshold is specified, clicking OK will start the analysis.

Figure 60: Batch Peak Search Tool.
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The tool will sequentially analyze all spectra in each of the files specified by the filter. The results will be 
stored in .csv files which are located in the Temp directory (default is C:\GADRAS-DRF\Temp). These 
files can be opened in Excel. The following data is stored in the csv file:

 Energy (keV)
 Energy uncertainty (sigma)
 Count Rate (counts per second)
 Count Rate uncertainty (sigma)
 Full-Width at Half Max (keV)
 FWHM uncertainty (sigma)
 Leakage (photons per second)
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10 GADRAS-DRF SETTINGS

GADRAS-DRF has some settings that users can modify to customize the user interface. These options 
consist of:

 Change plot options on detector change (default on): GADRAS-DRF will change the plot style of 
the first spectrum depending on if the detector is high resolution (e.g. HPGe) or low resolution 
(e.g. NaI)

 Automatically update plot when fields change (default off): with this turned on, users can update 
the spectrum viewer automatically when they change any field on the Plot tab (Foreground, 
Background, Compute Source term)

 Don’t show energy calibration dialog (default off): when doing the graphical energy calibration 
(Section 6.3), this option determines whether GADRAS-DRF will automatically ask which 
calibration parameter to adjust

 Adjust plot scale with mouse wheel (default on): if selected, the mouse wheel will adjust the y-
axis scale on the spectrum viewer; if not selected, the mouse wheel will zoom in

 Animate zoom (default on): if selected, the spectrum viewer will zoom in with an animation
 Open ROI in new window (default off): if selected, zooming in will open a new spectrum viewer 

with the zoomed spectrum; otherwise, the zoom will remain on the same window
 Reset Dialogs button: when pressed, this reset the GUI to show all dialog boxes until user checks 

the option to not show the dialog again
 Save DLL Log button: if GADRAS-DRF functions incorrectly, this button can be used to save 

the error to a file
 Exit splash screen upon load (default off): checking this will exit the initial GADRAS-DRF 

splash screen as soon as GADRAS-DRF is ready for user interaction, otherwise it will stay visible 
for a full three seconds

 Turn off autocomplete (default off): the Computed Source line on the Plot tab has an 
autocomplete feature; if desired, this functionality can be turned off

 Rebin spectra when inserting to files (default off): if checked, spectra will be rebinned according 
to the Rebin.dat file structure (Section 9.3.1) whenever they are added to a PCF file via the PCF 
Viewer
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